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Preface 
 
This guidebook introduces the procedures to replace PFXSP5700WCD + PFXSP5B41 with PS6000 series 
15-inch Wide Display Module + Basic Box Module. The recommended replacement models are as shown 
below.  
 
 

* The PS6000 series 15-inch Wide Display Module is hereinafter called PS6000 15”W and the PS6000 series 

Basic Box Module is called BasicBox. 

 

 

Currently used device  Recommended replacement model 

SP-5700WCD  

(Premium Display) 

+ SP-5B41 (Open Box) 
PFXSP5700WCD + 

PFXSP5B41 

or PFXSP5B411 

or PFXSP5B412 

⇒ 
PS6000 15”W + Basic Box (Atom) 
Model：PFXP6AFxxxxxxxxx00 (Intel X6211E Atom 2 Cores DIMM-4GB) 

 
 
 
 

Safety Information 

To properly use the products described in this book, please follow the directions below. 

●Be sure to read the manual and the other provided documents before use. 

●Only persons with the expertise of electrical equipment construction method and related 

law and also the adequate skills should be allowed to install, connect, and maintain the 

products. 

We are not responsible for death, serious injury or unintended equipment damage 
incurred as the result of failure to follow these instructions. 
 
 

Trademarks 
Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries. 
Intel®, Celeron®, Atom®, Core™2 Duo and Core™ i3/5/7 are trademarks of Intel Corporation. 
Other product names used in this manual may be the registered trademarks owned by the respective 
proprietors. 
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Models of PS6000 series 
PS6000 series are products of CTO (Configure To Order). 
Please confirm CTO models on the Web site before placing orders at the time of purchase. 
 
Generate CTO models. 
https://www.proface.com/en/product/ipc/ps6000/configurator 
 

https://www.proface.com/en/product/ipc/ps6000/configurator
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Chapter 1 Specifications Comparison 

1.1 Comparison of display specifications between SP-5700WC + SP-5B41 and PS6000 

15”W + Basic Box 

Display Specifications 

 SP-5700WC +  

SP-5B41 

PS6000 15”W +  

Basic Box 

 

 

 

 

 

 

 

 

 

 

Display Type TFT Color LCD (15” Wide) 

Display Resolution FWXGA 1366 x 768 

Display Colors 262,144 colors Approx.16 million colors 

Backlight 
White LED (not user replaceable. When replacement is required, contact 

customer support.) 

Brightness control 101 levels (adjusted with touch panel or software) 

Backlight service life 
50,000 hours or more (continuous operation at 25 °C [77 °F]-ambient 

temperature- before backlight brightness decreases to 50%) 

Brightness Sensor Yes None 

Touch 

panel 

Type Projected Capacitive (multitouch) 

UP! Projected capacitive touch panel  

(multitouch, simultaneous touch 

number-2) with optimized noise filter 

Mode None 

UP! 3 modes 

（Changeable - Standard Mode, 

Water Detection Mode, and Glove 

Mode） 
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1.2 Comparison of performance specifications between SP-5700WC + SP-5B41 and PS6000 15”W + 

Basic Box 

Performance Specifications 

 
SP-5700WC +  

SP-5B41 

PS6000 15”W +  

Basic Box 

CPU 

 Atom E3825 
UP! Atom 

X6211E 

Base frequency 1.33 GHz 1.30 GHz 

Max turbo boost 

frequency 
- 

UP! 3.00 GHz * 

*Default: disable 

enable from BIOS 

L2 cache 1 MB 1.5 MB 

Core number 2 2 

Thread number 2 2 

Main memory 

SP-5B41: 

DDR3L 1066 MHz - SDRAM 2 GB 

 

SP-5B411/412:  

DDR3L SDRAM 4 GB 

UP! 260-pin SO-DIMM socket x 2, 

DDR4-3200 (Up to 32GB for 2 sockets) 

 

UP! Support In-band ECC 

Graphics accelerator 
Intel® HD Graphics for Intel Atom® 

Processor Z3700 Series 

UP! Intel® UHD Graphics for 10th Gen 

Intel® Processors 

Security chip - UP! TPM 2.0 

BIOS Legacy BIOS UP! UEFI BIOS 

Operating system 

SP-5B41:  

Open Box (Windows® Embedded 

Standard 7 Service Pack 1) 

 

SP-5B411/412:  

Windows® 10 IoT Enterprise 2019 

LTSC 32 bit 

UP! Windows® 10 IoT Enterprise 2021 

LTSC (64bit) *1 

Watchdog timer - 

New! Timeout setting from either 1 to 

255 seconds, or 1 to 255 minutes, is 

possible (set up using API)  

Buzzer Yes Yes 

 
*1 OS will be different between SP5000 and PS6000. Be aware that SP-5B411/412 windows 10 and 
PS6000 Basic Box is both Windows 10 but different version. Some software might have no compatibility. 
SP-5B411/412 : Windows® 10 IoT Enterprise 2019 LTSC (32 bit) 
PS6000 Basic Box : Windows® 10 IoT Enterprise 2021 LTSC (64bit) 
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1.3 Comparison of general specifications between SP-5700WC + SP-5B41 and PS6000 15”W + 

Basic Box 

General Specifications 

 
SP-5700WC +  

SP-5B41 

PS6000 15”W +  

Basic Box 

Panel cut dimensions W396.0 mm x H277.0 mm 

W394.0 mm x H250.0 mm 

*Need a panel cut adapter 

(PFXZHAT7W1) 

Panel thickness 1.6 mm to 5 mm 

External dimensions 

(including bezel) 
W414.0 x H295.0 x D69 mm W408.0 x H264.0 x D69 mm 

Front bezel material Aluminum 

Weight 5.9 kg or less 5.7 kg or less 

Cooling method 
Natural air circulation (fanless) 

→See 2.1 

Power supply DC power supply：24V DC power supply: 24V 

Power 

consump

tion 

DC 
When backlight is off: 27.5 W or less 

Max: 42 W 

When backlight is off: 29 W 

No power supplied to outside: 41 W 

Max: 59 W 

AC  - - 

UPS for battery 

backup 
- 

No exclusive option 

*please us third device  

recommend : APC SMT500J Smart-

UPS500 

 

 



 9 

1.4 Comparison of interface specifications between SP-5700WC + SP-5B41 and PS6000 15”W + 

Basic Box 

Interface Specifications 

 
SP-5700WC +  

SP-5B41 

PS6000 15”W + 

Basic Box 

Serial 

（D-Sub 

9-pin 

plug） 

Main 

unit 

COM1: RS-232C/422/485 (non-

isolated) 

COM2: RS-232C/422/485 (non-

isolated) 

(default: RS-485, enable by 

launcher) 

COM1: RS-232C/422/485 (non-isolated) 

COM2: RS-232C/422/485 (non-isolated) 

(default: RS-485, enable by BIOS) → See 

2.2 

 

*not support VCC(DC5V) output function 

of RS232C COM port 

Option - 

Select any of the following 

PFXYP6M2R23P2 : RS-232C isolated 

type ｘ2  

PFXYP6M2R42P2 : RS-422/485 isolated 

type ×2 * 

→ See 3.3 

* No compatibility in case of RS-422 using 

RTS+/- or CTS+/-. But even in other case, 

if application or connected device is 

controlling send/receiving by monitoring 

RTS or CTS, it could not be communicated. 

If able to change to software flow control, it 

is avoidable. 

Disk 

CFast Card 32 GB x 1 

 

SDXC Card x1 

UP! M.2 SSD 128GB as default, support 

up to 512GB x2* 

SDXC Card x1 

*2nd SSD could be use when no option 

interface or Wifi/Bluetooth interface 

module. 

With other option module, only single SSD 

can be use → See 3.2 

USB 

USB Type-A x3 (2.0） 

USB Type-mini-B x1 (2.0）* 

*for transporting project file 

UP! USB Type-A x2 (3.0） 

UP! USB Type-C x1 (3.2） 

*Project transfer will be done by :  

Ethernet 

USB A transfer cable (PFXZC3CBUSA1)  

USB Memory 

SD Card 

Ethernet 
EEE802.3, 10BASE-T/100BASE-

TX/1000BASE-T x2 

UP! IEEE1588, 10 BASE-T/ 100 BASE-

TX/1000BASE-T, Wake on LAN (WOL) 

supported x2 

* When status is S4 (hybrid shutdown), Wake on 

LAN cannot be used. 

Sound 
Line input/Line output/Microphone 

input 

Line output/Microphone input 

(Option: PFXYP6CVUSAU)  

Video output DVI-D Output Interface x 1 

UP! Display port x1 (Dual mode 

supported) 

UP! USB 3.0 (Type C Displayport 

Alternate mode) x 1 

→ See 2.3 

Option Interface 

Slot 
- 

1 slot 

*For valid combination →See 3.2 
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Chapter 2 Hardware Compatibility 
2.1 Cooling storage media 

When installing the M.2 SSD for second storage, the optional M.2 cooling kit is required. (PFXYP6HSM2B) 

 Storage media M.2 cooling kit 

Basic Box 

M.2 SSD - 

M.2 SSD (Second Storage)     

CF Card - 

 

1. Remove 3 screws on the front side of the Box Module. 

 

2. Remove the optional interface cover. 

 

3. Peel off the protective film from the top surface and bottom surface of the heat sink pad. 

Place the heat sink pad on the board 

 

4. Insert the M.2 screw in the M.2 SSD card. 



 11 

 

5. Insert the M.2 SSD card in the slot.  Secure the M.2 SSD card with the M.2 screw 

 

 

2.2 Settings of Serial Interfaces on Box Module 

The following describes how to configure the serial interfaces on Box Module. 

1. Turn on the product. While the boot screen is displayed, press either the [DEL] or [ESC] key. Enter the 

password (default password: Pw#12345). The BIOS screen will display. 

2. Select Advanced > Super IO Configuration > Serial Port 1 or Serial Port 2 

3. Select Enabled or Disabled in Serial Port (default: Enabled). 

4. Select a communication method in Mode Selection (default: RS485). 
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2.3 Video output interface 

PS6000 series supports 3 video output interfaces. Simultaneous output of all the interfaces is possible. 

 

 
 

 

A: Display Module Interface 

B: USB Type C 

C: Display Port 
 

Setting Tool Duplicate Extension Scaling 

Windows standard display setting 2 screens max 3 screens max Scaling down only 

Intel Graphics Command Center 3 screens max 3 screens max Scaling up/down 

 

Display 

Module 

Interface 

USB 

Type C 

Display 

Port 
Details 

Screen A Screen B Screen C 3 – extension display 

A B B 1-extension display (Display Module), 2-duplication display 

B A B 1-extension display (USB Type C), 2-duplication display 

B B A 1-extension display (DisplayPort), 2-duplication display 

A A A 3-duplication display (Intel Graphics Command Center is required) 

 

 

2.4 USB Type C 

The USB Type C of PS6000 series supports DP Alt Mode *1. 

PS6000 Basic Box Type C does not support USB-PD *2 

 
*1 DP Alt Mode (DisplayPort Alternative mode) is USB Type C port which could connect to display by 
convert adapter or cable of VGA, DVU, HDMI. DP.  
*2 USB-PD (Power Delivery) is USB port which able to connect to display by 1 cable. By Sending video 
signal and power. 
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Chapter 3 Optional items 

3.1 Options compatibility 

Most of SP5000 series option are usable for PS6000 Atom Basic Box. 

(Display option’s reference are for 15inch) 

SP5000 series PS6000 series 

Product Name Model Compatibility 

COM Port Conversion Adapter PFXZC3ADCM1     

Terminal Block Conversion Adapter PFXZC3ADR41     

RS-232C Cable (5m) PFXZC3CBR251     

RS-422 Cable (5m) PFXZC3CBR451     

Mitsubishi PLC A-Series Connection Cable (5m) PFXZC3CBA51     

9-pin-to-25-pin RS-232C Conversion Cable (0.2m) PFXZC3CBCVR21     

Mitsubishi PLC FX-Series Connection Cable PFXZC3CBFX11     

Mitsubishi PLC FX-Series Connection Cable PFXZC3CBFX51     

Mitsubishi PLC Q-Series Link Cable(5m) PFXZC3CBQL51     

Mitsubishi PLC Q-Series Connection Cable (5m) PFXZC3CBQ51     

Omron PLC SYSMAC Link Cable(5m) PFXZC3CBSYS51     

Screen Protection Sheet PFXZC3DS151     

Connects a USB printer. (TYPE-B) PFXZC0CBUS1     

RS-422 Terminal Block Conversion Adapter PFXZCBADTM1     

RS-422 9/25-pin Conversion Cable (0.2m) PFXZCBCBCVR41     

Multi-Link Cable (5m) PFXZCBCBML1     

SD Memory Card (4 GB) PFXZCBSD4GC41     

EZ Illuminated Switch PFXZCCEUSG1     

Front USB cover for NEMA/ATEX PFXZCDCVUS1     

SD Memory Card (1 GB) for System Card PFXZCDSD1GC61     

Auxiliary Output / Speaker Output Interface PFXZCDCNAUX1 - *1 

UV Protection Sheet PFXZCFUV151 - 

Environment Cover PFXZCDOP151 - 

Anti-Glare Sheet PFXZCHAG152 - *2 

Replacement Battery PFXZCBBT1 - 

Multi Display Adapter PFXZCDADEXR1 - *3 

 
*1 Audio option with 3.5 Audio interface available (PFXYP6CVUSAU)  
*2 New Anti-Glare Sheet available (PFXZCAG7W1 
*3 PS6000 can connect with 3 displays. Detail on 2.4 Video output interface 

 

3.2 Options Slot table 

Option Slot (except WiFi/Bluetooth) and 2nd M.2 SSD use same interface, so 2nd SSD could be only use 

with WiFi/Bluetooth option or no option module. 

Option slot fit only one option module frame, so option module can be use only one at a time. 

Option Slot 2nd M.2 SSD 

RS-232C x2  

RS422/485 x2  

Ethernet  

4G Cellular  

WiFi/Bluetooth     

No Option Module     
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3.3 Option Interface of RS-422/485 isolated x2 

This Option Interface has dip switch. Termination resistor setting is necessary. Set up by referring 

to the following table. Switching RS-485 and RS-422 is also configured with the dip switch. 

DIP SW OFF ON Description 

1 Normal Termination (120 ohm) for COM3. Default: OFF 

2 Normal Termination (120 ohm) for COM4. Default: OFF 

3 RS-485 RS-422 Default: OFF 

4 Unused (disabled) Default: OFF 

 

 

 

Along with DIP switch settings, both ports must be set in the Windows® Device Manager too. 

NOTE: Auto direction control is automatically enabled with this setting. 

1. Open the Windows® Device Manager. 

2. Open Ports 

3. Right-click the port to which RS-485 or RS-422 is assigned 

 

 

4. Select Properties and open the Port Settings tab. 

5. Select the RS-485 check box. 

NOTE: 

- Select the RS-485 check box even for RS-422. 

- Do not change any settings other than RS-485. 
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3.4 Option Interface of RS-422/485 isolated PIN assign 

Option Interface of RS-422/485 isolated PIN assign is different with PS6000 Basi Box COM port and 
SP5000 Open Box COM port. 

Pin# PS6000 Basic Box 

COM port 

SP5000 Open Box 

COM port 

PS6000 Basic Box 

RS422/485 x2 isolation option  

1 RDA RDA TxD-/Data- 

2 RDB RDB TxD+/Data+ 

3 SDA SDA RxD+ 

4 ERA ERA RxD- 

5 SG SG SG 

6 CSB CSB NC 

7 SDB SDB NC 

8 CSA CSA NC 

9 ERB ERB NC 
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Chapter 4 Compatibility of software 

4.1 Supported OS and language 
The supported OS and language differ between SP5000 series and PS6000 series. 

OS SP5000 series PS6000 series 

Windows Embedded Standard 7 Service Pack 1 Yes (PFXSP5B41) No 

Windows 10 IoT Enterprise 2019 LTSC Yes (PFXSP5B411/412) No 

Windows 10 IoT Enterprise 2021 LTSC (64 bit) No Yes 

 

 

Language 

SP5000 series PS6000 series 

Windows Embedded Standard 7 Service 

Pack 1 

Win 10 IoT Enterprise 2019 LTSC 

Windows® 10 IoT Enterprise 2021 

LTSC (64 bit) *2 

Chinese(Simplified) Yes/No *1 Yes 

Chinese(Traditional) Yes/No *1 Yes 

English Yes Yes 

French Yes Yes 

German Yes Yes 

Italian Yes Yes 

Japanese Yes Yes 

Portuguese Yes/No *1 Yes 

Russian Yes/No *1 Yes 

Spanish Yes Yes 

Swedish Yes/No *1 Yes 

 

*1: It’s necessary to add and install a language from the language pack. 

*2: Language that is not shown in the table can be downloaded from the Microsoft web site using the 

standard language feature of Windows. 
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4.2 OS login password 

For PS6000 series, it’s necessary to set a login password at the first boot of the product to reduce the risk 

of intrusion and infection of malicious software and unauthorized access. Unlike SP5000 series, you cannot 

configure settings without a password. The conditions of login password are as follows; 

 

The number of characters: 8 or more characters with 3 or more types included from the usable characters 

as shown below. The character strings used for the account name cannot be used. 

Types of usable characters: 

⚫ Upper-case characters of European languages (A to Z, diacritical mark, Greek alphabet, Cyrillic 

alphabet) 

⚫ Lower-case characters of European languages (a to z, hash sign, Greek alphabet, Cyrillic alphabet) 

⚫ Numbers (0 to 9) 

⚫ Characters (special characters) except alphanumeric characters: (~!@#$%^&*_-+=`|¥(){}[]:;"'<>,.?/) In 

this policy setting, the currency sign like Euro or British Pound is not counted as special characters 

⚫ Unicode characters that are neither upper-case nor lower-case characters though they are categorized 

in the order of alphabet. Unicode characters of Asian languages are included in this. 

 

4.3 Recovery media 

A recovery USB for OS recovery is attached to PS5000 series, but it’s an optional item for PS6000 series. 

Please purchase a recovery USB for PS6000 Basic Box (PFXYP6RUSW10B) for OS recovery. 

Using the recovery tool *1 on our web site makes recovery possible with the backup file created in advance. 

*1: https://www.proface.com/en/download/ps6000/application/restore_and_backup 

 

 

 

4.4 Supported software and utilities 
The software and utilities supported by PS6000 series are as follows; 

Software Version 

GP-Pro EX (WinGP) Ver. 4.09.500 or later 

Pro-Server EX Ver. 1.37.200 or later 

Pro-face Remote HMI (iOS/Android) Ver. 1.50 or later *1 

Pro-face Remote HMI Server Ver. 1.11.006 or later 

Pro-face Remote HMI Client for Win Ver. 1.42 or later 

BLUE 3.4 Service Pack 1 

BLUE Open Studio 2023 

Pro-face Connect (Link Manager) 11.0 

Pro-face Connect (Site Manager) 11.0 

 
*1: For earlier than Ver.1.50, PS6000 series (WinGP) is not recognized as a connection destination server. 
 
 

Utility Descriptions 

Buzzer Enable or disable the buzzer sound at the time of touch panel operation. 

Brightness Sets the backlight brightness. 

Calibration Correct touch positions. 

Front USB Permit or do not permit use of Front USB on Display Module. 

Write Filter Enable or disable the Write Filter feature. 

HORM Enable or disable the HORM feature. 

Shell 
Hide the Windows® desktop. Using this custom shell feature allows you to restrain the 
Windows® features such as Control Panel. 

Power Used to operate power supply of this product in a state of custom shell. 

System Show the product’s firmware, BIOS version, and OS version. 

Touch Mode Select from 3 modes (Normal, Water-detected, and Gloves) according to a use environment. 

System Monitor 
Monitor a state of the main unit, for example temperature or voltage, using a dashboard created 
with Node-RED. 

Window Locker Fix a window display position at the time of application boot when an external display is used. 

Cellular 
You can use the optional interface unit and a SIM card to data communication 
using 3G, 4G, and LTE radio waves. Double-click this icon will show the windows cellular option. 

 

https://www.proface.com/en/download/ps6000/application/restore_and_backup
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4.5 Supported features in Launcher compatibility 

The difference of supported System features in Launcher is as shown below. 

 PS6000  

Atom Basic Box 

SP5B411/412 

 (Windows 10) 

SP5B41  

(WES7) 

Launcher Supported Supported Supported 

Buzzer Supported Not supported Not supported 

Brightness Supported Supported Supported 

Calibration Supported Supported Supported 

Front USB Supported Supported Supported 

Write Filter Supported Supported Supported 

HORM Supported Supported Supported 

Shell Supported Supported Supported 

Power Supported Supported Supported 

System Supported Supported Supported 

Touch Mode Supported Not supported Not supported 

System Monitor Supported Not supported Not supported 

Window Locker Supported Not supported Not supported 

Cellular Supported Not supported Not supported 

HMI Icon Not supported Supported Supported 

Task Changer / 

Task Switcher 
Not supported Supported Supported 

Eject Not supported Not supported Supported 

UART Not supported Supported Supported 

 
* Launcher similar with the SP5000 Open Box’s launcher will be release later.  
  
 

4.6 Details of touch operation for every series 

Series Touch Type Driver 
Touch 

Detection 
Behavior when touch and 

hold 

Supports 
two-point 

touch 

PS5000 
Resistive Film 

PenMount 
Driver 

Pen Up 

Right Click (Default) 
- 

Capacitive     

PS5000 + DA *1 
Resistive Film Depend on the Host PC 

setting. 

- 

Capacitive     

FP5000 
Resistive Film 

Windows 
Standard 

Pen Down 

Depend on the Host PC 
setting. 

    
SP5000 + MDA *2 

PS6000 
Resistive Film 

Right Click (Default) 

    
Capacitive 

FP6000 
Resistive Film Depend on the Host PC 

setting. Capacitive 

 
*1: Display Adapter 
*2: Multi Display Adapter 
 

Mouse Emulation Software (DMT-DD) is also available > https://www.proface.com/en/node/50375 
Note when using on PS6000 Series 
- The multi-touch function does not operate. 
- It is not possible to use Calibration on the launcher. 
- DMT-DD does not support the extend mode in multi monitor. Please use on single monitor or set to the 
duplicate mode. 
- if you want to play the Touch Sound, please make the following settings 
Play Type : Hardware 
Sound Timing : At touch down 
Beep setting 
Frequency [Hz] : 2400 
Sound Duration [ms] : 50 
 
 
 
 
 
 
 

https://www.proface.com/en/node/50375
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4.7 GP-Pro EX project file 

Please follow below step in GP-Pro EX, to use SP5000 project file on PS6000. 

1.  Open the SP5000 project file. 

2.  Click Project > System Settings > Display.  

3.  Click Change Display. 

4.  Select as below for New Display fields. 

- Series: IPC Series (PC/AT) – PC/AT 

- Model: PC/AT 

- Screen Size: Select display size of PS6000 *1 e.g. 12.1” inch wide = 1280x800(WXGA)  

- Orientation: Landscape or Portrait *Usually same with current Display 

5. Click Change. 

 
6. Two pop-ups will be shown in a row. Read the mention and click Yes. 

 

 
 

*When [Historical Data Retentive Settings] error has been shown, please follow logging the data other 

than SRAM →4.8 

 

 
*1 if resolution is different from current display. Convert Resolution check box will be shown. When you want 

to convert to new resolution, put the check. After changing the resolution, ensure that the part and text sizes 

and positions are appropriate. 
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4.8 WinGP – Historical Data Retentive Settings 

4.8.1 Logging to external device 

When creating new project selecting IPC Series(PC/AT) – PC/AT, by enabling the logging, automatically 

logging data will be save to external drive. 

Minimum Historical Data Retentive Saving cycle will 1min. Saving enable size is bigger than SRAM. 

 

4.8.2 logging the data other than SRAM 

To setup D Drive for logging data, please follow below step in GP-Pro EX. 

Select Project > System settings > Display Unit. 

Select WinGP tab. Check the Folder and assign the location in Historical Data Storage Location 

 

 

4.9 BLUE Runtime License Manager 

Please follow below step to transfer the RT license activation to PS6000 from SP5000 Open Box. 

 

1. On SP5000 Open Box. Click Window Menu. Select Schneider Electric License Manager folder. Run 

License Manager. 

 
2. Click check box on the left of BLUE Runtime License (1). Don’t forget to take a memo of Activation ID. 

Click Return (2). 

 

 

3. Pop up window explaining Returning License will be shown. Click Yes. 

 

4. Pop up window explaining succeed of remove license will be shown. Click Finish. 
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5. On PS6000, Click Window Menu. Select Schneider Electric License Manager folder. Run License 

Manager. 

 

6. Click Activate button. 

 

 

7. Enter Activation ID in step2 to text box (1) 

Click Next > (2) 

 

 

8. Pop up window explaining succeed of activating license will be shown. Click Finish. 

 

*BLUE License has restriction of the number of deactivating and reactivating. 

Please contact support center for further detail. 
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4.10 BLUE Project file 

Please follow below step in BLUE, to use SP5000 project file on PS6000. 

1.  Open the SP5000 project file. 

2.  Click System Architecture > Target01 (1) *1.  

3.  Click 3 dots on the Series (2). 

 

4.  Select as below for New Display fields. 

- Type: IPC or PC/AT 

- Resolution: Select display size of PS6000  (e.g. 12.1” inch wide = 1280x800(WXGA)  

- Orientation: Landscape or Portrait *Usually same with current Display 

5 Click OK. 
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4.11 BLUE historical data location 

When select IPC or PC/AT, selection for logging data, for Logging and Alarm. will be Backup Memory or SD 

Card*1 or USB Storage*1. 

Below is the location of logging data for each selection. 

Please beware to re-assign the location when you change the project file to IPC or PC/AT from SP5000. 

 

 

 

Backup Memory 

Save to Folder will be automatically created in the C Drive.  

 

SD Card 

USB Storage 

Location can assign in System Architecture > Target01 > Function > Options > Destination Folder. 

 

 

*1 simply selecting [SD Card] or [USB Storage] will NOT store the alarm history in the SD card or USB 

storage inserted in the display unit. To save the alarm history in the SD card or USB storage, specify the 

destination folder in the [Destination Folder (SD Card)] or [Destination Folder (USB Storage)] 

 

 

 

 

 

 

 

 

 

 

 



 24 

4.12 Software notice when Writer Filter is enabled 

When Write Filter(UWF) is enabled, data will be reset when restarting the product. 

Software data such as variable data, will be also reset. If you need to avoid this, please create symbolic link 

of software folder to second device or external device 

 

Default software folder :  

BLUE : “C:¥ProgramData¥Pro-face¥BLUE Runtime” 

GP-Pro EX : “C:¥ProgramData¥Pro-face¥WinGP” 

 

Example of creating BLUE symbolic link folder C:¥ProgramData¥Pro-face¥BLUE Runtime 

1. Disable Unified Write Filter 

a. Start Launcher from the shortcut icon on the Desktop 

 

b. Select Write Filter from Launcher top screen  

If Write Filter is not displayed on the Launcher top screen, click on Edit to display Write Filter 

 

c. Disable (Off) Write Filter on C: 

  

Toggle the switch to Off 

 

2. Create a new folder D:¥PS6000. 

3. Cut and paste BLUE Runtime folder from the C:¥ProgramData¥Pro-face to D:¥PS6000 folder. 

Ensure to Cut and Paste, and not to Copy and Paste 

Note: C:¥ProgramData is a hidden folder by default in Windows. Please enable Hidden items from View 

menu on Windows Explorer Window.  
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Folder to Cut from C: drive. 

 

4. Click Windows Start button > Open Command Prompt as Administrator 

 
 

4. Input < mklink /D “C:¥ProgramData¥Pro-face¥BLUE Runtime” “D:¥PS6000¥BLUE Runtime”> and 

press Enter key. 

After successful creation of the symbolic link, there will be following message: 

“symbolic link created for C:ProgramData¥Pro-face¥BLUE Runtime <<===>> D:¥PS6000¥BLUE 

Runtime” 

 

 

5. Enable Write Filter for C: drive 

a. Start Launcher from the shortcut icon on the Desktop 
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b. Select Write Filter from Launcher top screen  

If Write Filter is not displayed on the Launcher top screen, click on Edit to display Write Filter 

 

c. Enable (On) Write Filter on C: 

 
Toggle the switch to On. 

 

 

Only Alarm, logging and historical data needs to avoid the reset, changing the save folder to external device 

will resolve this concern. GP-Pro EX →See 4.8  BLUE →See 4.11  

 

However, even in this case, PS6000 needs to be shut down correctly from Windows. If there is a shut down 

from other cases (e.g. power supply cut-off to PS6000), data could be damaged and could cause issues in 

saving. 

 

Using the symbolic link to protect variable data from resetting require two separate storage drives.  

(Symbolic link will not work properly for virtually partitioned drives) 

 

 


